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About This Content

This guide provides information about the Address Correction utility. The Address Correction
utility is a part of Oracle Communications MetaSolv Solution (MSS) Utilities.

Audience

This guide is intended for individuals responsible for maintaining end user locations.

Documentation Accessibility

For information about Oracle's commitment to accessibility, visit the Oracle Accessibility
Program website at http://www.oracle.com/pls/topic/lookup?ctx=acc&id=docacc.

Access to Oracle Support

Oracle customers that have purchased support have access to electronic support through My
Oracle Support. For information, visit http://www.oracle.com/pls/topic/lookup?ctx=acc&id=info
or visit http://www.oracle.com/pls/topic/lookup?ctx=acc&id=trs if you are hearing impaired.

Conventions

The following text conventions are used in this document.

Convention Meaning

boldface Boldface type indicates graphical user interface elements associated with an
action, or terms defined in text or the glossary.

italic Italic type indicates book titles, emphasis, or placeholder variables for which
you supply particular values.

monospace Monospace type indicates commands within a paragraph, URLs, code in
examples, text that appears on the screen, or text that you enter.
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1
Getting Started

This chapter introduces the Address Correction utility. The Address Correction utility is a part of
Oracle Communications MetaSolv Solution (MSS) Utilities. This chapter provides an overview
of the utility and instructions about setting up and running the utility.

Need for Address Correction
In MSS, inconsistencies related to end user locations (EUL) may exist that can cause the
following issues:

• You view multiple end user locations that have the same address.

• You view multiple active addresses of the same address structured format at the same end
user location.

• You view an end user location (L1) that has an address in MSAG structured format and
another end user location (L2) has that same address in OBF structured format.

• You receive inaccurate information when you run a report that prevents you from:

– Viewing all the services on a particular end user location

– Analyzing the feasibility of providing a new service

You use the Address Correction utility to resolve inconsistencies related to end user locations,
which in turn provides usability and reporting capabilities.

About the Address Correction Utility
The Address Correction utility enables you to resolve inconsistencies related to end user
locations in the following scenarios:

• Multiple end user locations having the same address. See "Resolving Multiple EULs
Having the Same Address" for more information.

• Multiple active addresses of same address format at the same end user location. See
"Resolving Multiple Active Addresses of the Same Address Format per EUL" for more
information.

• Multiple end user locations having the same address components in MSAG and OBF
structured formats. See "Resolving Multiple EULs with the Same Address in MSAG and
OBF Structured Formats" for more information.

Installing and Setting Up the Address Correction Utility
The Address Correction utility is a part of MetaSolv Solution Utilities. See MetaSolv Solution
Installation Guide for information about installing and setting up MetaSolv Solution Utilities.

Running the Address Correction Utility
To run the Address Correction utility:
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1. Double-click mss_util.exe.

The Logon to Utilities window is displayed.

2. In the User ID field, enter your user name.

3. In the Password field, enter your password.

4. From the Database list, select the database to which the Utilities should connect.

5. Click OK.

The MetaSolv Solution Utilities is displayed.

6. From the Options menu, select Address Correction Utility, then Address Correction.

The Address Correction utility is displayed.
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2
Address Correction Utility User Interface

This chapter provides information about the Address Correction utility user interface.

Address Correction Utility Tabs
The Address Correction utility has the following tabs:

• Criteria Tab

• Results Tab

• Preferences Tab

Criteria Tab
The Criteria tab enables you to specify the scenario and its related search criteria to search for
end user locations (EULs) that have inconsistencies.

Figure 2-1 shows the Criteria tab.
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Figure 2-1    Criteria Tab

The Criteria tab has the following options under the I want to find area:

• Multiple EULs having same address: Select this option to search for multiple end user
locations that have the same address. See "Resolving Multiple EULs Having the Same
Address" for more information.

• Multiple active address per EUL per address structured format: Select this option to
search for multiple active addresses of the same address structured format at the same
end user location. See "Resolving Multiple Active Addresses of the Same Address Format
per EUL" for more information.

• Multiple EULs with same address in MSAG and OBF structured formats: Select this
option to search for multiple end user locations that have the same address components in
Master Street Address Guide (MSAG) and Ordering and Billing Forum (OBF) structured
formats. See "Resolving Multiple EULs with the Same Address in MSAG and OBF
Structured Formats" for more information.

Table 2-1 lists the fields on the Criteria tab.
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Table 2-1    Fields on the Criteria Tab

Field Description

Limit Number Found To The maximum number of records to be retrieved for the search. The value that you specify in
this field must not exceed the retrieval limit value that you specified in the Search Retrieval
Limit preference located under Preferences - System Information in the MSS application.

See "Setting the Maximum Number of Records to Be Retrieved" for more information.

Search Click to retrieve information based on your search criteria.

Clear Clears the specified search criteria.

Set Criteria Lets you specify wild cards to the search criteria.

See "Setting the Search Criteria" for more information.

View Log Opens the View Log window, which displays the log information.

Network Loc Name Name of the network location.

End User Loc Name Name of the end user location.

Country Lists all the countries that have a valid address structured format.

Lists United States as the only option for the following scenario:

• Multiple EULs with the same address components in MSAG and OBF structured
formats. See "Resolving Multiple EULs with the Same Address in MSAG and OBF
Structured Formats" for more information.

Format Lists the address structured formats valid for the selected country.

Based on the format you select, the appropriate address fields are displayed for search. Only
those address fields are displayed that have the Search By check box selected in Structured
Formats setup. The Search Required check box must be selected in Structured Formats
setup for mandatory address search fields in corresponding component in structured format.

Lists an additional option, Query across all Address Formats, for the following scenario:

• Multiple EULs having the same address. See "Resolving Multiple EULs Having the
Same Address" for more information.

Selecting a format from this list is mandatory for the following scenario:

• Multiple active addresses of the same address format per EUL. See "Resolving Multiple
Active Addresses of the Same Address Format per EUL" for more information.

Lists only the North American Master Street Address Guide and OBF Service Address
Location Information formats for the following scenario:

• Multiple EULs with the same address components in MSAG and OBF structured
formats. See "Resolving Multiple EULs with the Same Address in MSAG and OBF
Structured Formats" for more information.

Setting the Maximum Number of Records to Be Retrieved
On the Criteria tab, the value that you specify in the Limit Number Found To field determines
the maximum number of records to be retrieved for the search. The value that you specify in
this field must not exceed the retrieval limit value that you specified in the Search Retrieval
Limit preference located under Preferences - System Information in the MSS application.

If the retrieved records exceed the specified retrieval limit in the Limit Number Found To field,
a warning message displays the value that you must specify in the Limit Number Found To
field and search again to retrieve all the records.

For example, you may enter 300 in the Limit Number Found To field and the total number of
records is 320.
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In this case, when you click Search, a warning message displays 320 as the required value
that you must specify in the Limit Number Found To field. If you click OK on the warning
message, the Results tab displays only 300 records.

To retrieve all 320 records, in the Limit Number Found To field on the Criteria tab, enter 320
and click Search.

Setting the Search Criteria
On the Criteria tab, the Set Criteria button lets you specify partial names using wild cards if
you do not know the full name to specify in your search criteria.

To set the search criteria:

1. On the Criteria tab, click the field where you want to specify the partial name.

2. Click Set Criteria.

The Set Selection Criteria window is displayed.

3. Select one of the following options:

• Contains

• Begins With

• Ends With

• Is Less Than

• Is Greater Than

• Equals

• Is Not Equal To

4. Enter the partial name in the field under the options and click OK.

For example, if you select Begins With and enter HOU in the field under the options and
click OK, the expression Like HOU% is displayed in the field where you want to specify the
partial name.

5. Click Search.

The results are displayed in the Available Groups area on the Results tab.

Table 2-2 lists the partial search criteria options and the expressions that these options
populate in the field where you want to specify the partial name on the Criteria tab. In the
Expression column, HOU is an example of the partial name you enter in the field in the Set
Selection Criteria window.

Table 2-2    Partial Search Criteria Options and Their Populated Expressions

Option Expression

Contains Like %HOU%

Begins With Like HOU%

Ends With Like %HOU

Is Less Than <HOU

Is Greater Than >HOU

Equals =HOU

Is Not Equal To <>HOU
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Results Tab
The Results tab enables you to:

• View the information that is retrieved based on the search criteria you specified

• View the impacted entities associated with the end user location

• Resolve the existing inconsistencies related to end user locations

Figure 2-2 shows the Results tab for the scenario in which multiple end user locations have
the same address.

Figure 2-2    Results Tab

The Results tab has the following areas:

• Available Groups Area

• Selected Groups Area

• Subtabs on the Results Tab

• Resolution Options Area

Available Groups Area
The Available Groups area displays the following information depending on the scenario:

• Groups of end user locations having the same addresses. Each group of end user
locations is displayed under an address ID and address that represents the same address
within the end user locations. Each group displays the EUL ID, location ID, end user
location name, address format, entity count, modified date, and modified user ID for each
end user location within that group. This information is displayed if you select the Multiple
EULs having same address option on the Criteria tab. See Table 2-3 for more
information on the columns in the Available Groups area.
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• Groups of addresses having the same end user location. Each group of addresses is
displayed under an EUL ID, location ID, and end user location name that represents the
end user location that contains the multiple active addresses of the same format. Each
group displays the address ID, address, address format, modified date, and modified user
ID of each active address within that group. This information is displayed if you select the
Multiple active address per EUL per address structured format option on the Criteria
tab. See Table 2-3 for more information on the columns in the Available Groups area.

• Groups of end user locations having the same address components in MSAG and OBF
structured formats. Each group of end user locations is displayed under an address that
represents end user locations having the same address components in MSAG and OBF
structured formats. Each group displays the EUL ID, address ID, location ID, end user
location name, address format, entity count, modified date, and modified user ID for each
end user location within that group. This information is displayed if you select the Multiple
EULs with same address in MSAG and OBF structured formats option on the Criteria
tab. See Table 2-3 for more information on the columns in the Available Groups area.

In the Available Groups area, you can do the following:

• Expand and collapse each EUL ID and Address ID node.

When you collapse the EUL ID or Address ID node, the Address Correction utility displays
the following information in parenthesis beside the collapsed EUL ID/Address ID node:

– Total number of rows in the group

– Total number of selected rows in the group

For example, (Total: 243 Selected: 12)

• Select multiple rows. To do so, press and hold the Ctrl key and click the rows.

• Select a range of rows. To do so, press and hold the Shift key and select the range of
rows.

• Select all the rows in a group by clicking the EUL ID/Address ID header row.

• Click the row for an end user location to view the count of entities associated with a
specific end user location in that group. In the Entity Count column, click the Count link to
view the total count of entities that are associated with all the end user locations within that
group.

The Count link is available only for the following scenarios:

– Multiple EULs having the same address. See "Resolving Multiple EULs Having the
Same Address" for more information.

– Multiple EULs with the same address in MSAG and OBF structured formats. See
"Resolving Multiple EULs with the Same Address in MSAG and OBF Structured
Formats" for more information.

• Click on a row to retrieve information related to the subtabs on the Results tab.

• Double-click any row to view the End User Location Maintenance window.

Selected Groups Area
The Selected Groups area displays the following information depending on the scenario:

• Groups of end user locations having the same addresses. Each group of end user
locations is displayed under an address ID and address that represents the same address
within the end user locations. Each group displays the EUL ID, location ID, end user
location name, address format, entity count, modified date, and modified user ID for each
end user location within that group. This information is displayed if you select the Multiple
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EULs having same address option on the Criteria tab. See Table 2-3 for more
information on the columns in the Selected Groups area.

You can select any one of these end user locations as your primary end user location. The
primary end user location is the only end user location that is retained after the resolution
process completes successfully. All the remaining end user locations are replaced by the
selected primary end user location. See "Resolution Options Area" for more information
about the available resolution options.

• Groups of addresses having the same end user location. Each group of addresses is
displayed under an EUL ID, location ID, and end user location name that represents the
end user location that contains the multiple active addresses of the same format. Each
group displays the address ID, address, address format, modified date, and modified user
ID of each active address within that group. This information is displayed if you select the
Multiple active address per EUL per address structured format option on the Criteria
tab. See Table 2-3 for more information on the columns in the Selected Groups area.

You can select any one of these addresses as your primary address. The primary address
is the only address that is retained after the resolution process completes successfully. All
the remaining addresses are replaced by the selected primary address. See "Resolution
Options Area" for more information about the available resolution options.

• Groups of end user locations having the same address components in MSAG and OBF
structured formats. Each group of end user locations is displayed under an address that
represents end user locations having the same address components in MSAG and OBF
structured formats. Each group displays the EUL ID, address ID, location ID, end user
location name, address format, entity count, modified date, and modified user ID for each
end user location within that group. This information is displayed if you select the Multiple
EULs with same address in MSAG and OBF structured formats option on the Criteria
tab. See Table 2-3 for more information on the columns in the Selected Groups area.

The end user location that has the address in OBF structured format is selected as the
primary end user location by default. After the resolution process completes successfully,
the end user location that has the address in MSAG structured format is merged into the
primary end user location that has the address in OBF structured format. See "Resolution
Options Area" for more information about the available resolution options.

In the Selected Groups area, you can do the following:

• Expand and collapse each EUL ID and Address ID node.

When you collapse the EUL ID or Address ID node, the Address Correction utility displays
the following information in parenthesis beside the collapsed EUL ID/Address ID node:

– Total number of rows in the group

– Total number of selected rows in the group

For example, (Total: 243 Selected: 12)

• Select multiple rows. To do so, press and hold the Ctrl key and click the rows.

• Select a range of rows. To do so, press and hold the Shift key and select the range of
rows.

• Select all the rows in a group by clicking the EUL ID/Address ID header row.

• Click the row for an end user location to view the count of entities associated with a
specific end user location in that group. In the Entity Count column, click the Count link to
view the total count of entities that are associated with all the end user locations within that
group.

The Count link is available only for the following scenarios:
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– Multiple EULs having the same address. See "Resolving Multiple EULs Having the
Same Address" for more information.

– Multiple EULs with the same address in MSAG and OBF structured formats. See
"Resolving Multiple EULs with the Same Address in MSAG and OBF Structured
Formats" for more information.

Table 2-3 lists the columns in the Available Groups and Selected Groups areas.

Table 2-3    Columns in the Available Groups and Selected Groups Areas

Column Description

EUL Id A unique identifier for an end user location.

End User Location Name Name of the end user location.

Location Id ID of the location.

Address Id A unique identifier for an address.

Address Address of the active address.

Address Format Address structure format for the address.

Entity Count Shows the total count of entities that are associated with multiple end user locations.
Contains the Count link.

Modified Date The date on which the information about the end user locations or addresses was modified.

Modified Userid The user who modified the information about the end user locations or addresses.

Check Box Select the check box beside the row for the end user location/address that you want to set as
the primary. The primary end user location/address is the only end user location/address that
is retained after the resolution process completes successfully.

Moving Rows Between the Available Groups and Selected Groups Areas
Table 2-4 lists the options that enable you to move rows between the Available Groups and
Selected Groups areas.

Table 2-4    Options for Moving Rows Between Available Groups and Selected Groups Areas

Option Description

Single Arrow Moves the selected end user location/address rows between the Available Groups area and
the Selected Groups area.

Double Arrow Moves all the end user location/address rows between the Available Groups area and the
Selected Groups area.

Subtabs on the Results Tab
The Results tab has the following subtabs:

• Circuit Subtab

• Equipment Subtab

• Customer Account Subtab

• Network System Subtab

• Service Request Subtab
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• Dedicated Plant Subtab

Circuit Subtab
The Circuit subtab provides information about all the circuits whose originating/terminating
location or the corresponding Local Service Offices (LSOs) is the selected end user location,
regardless of the status of the circuit.

Table 2-5 lists the columns on the Circuit subtab.

Table 2-5    Columns on the Circuit Subtab

Column Description

Identification ECCKT (circuit ID) of the circuit.

Originating Location Originating location of the circuit.

Terminating Location Terminating location of the circuit.

Originating Name/ID Name/ID of the originating network element associated with the circuit.

Terminating Name/ID Name/ID of the terminating network element associated with the circuit.

Status Status of the circuit.

Equipment Subtab
The Equipment subtab provides information about all the equipment associated with the end
user location, regardless of the status of the equipment.

Table 2-6 lists the columns on the Equipment subtab.

Table 2-6    Columns on the Equipment Subtab

Column Description

Type Type of the equipment.

Equipment Spec Manufacturer, part number, issue number, and acronym for the equipment specification.

CLEI Equipment code, as defined by iconectiv COMMON LANGUAGE Equipment Identifier.

Name Name associated with an installed piece of equipment.

Status Status of a piece of equipment.

Network Location Location where the equipment is installed.

End User Location Name Name of the end user location.

Customer Account Subtab
The Customer Account subtab provides information about the customer accounts that have
services associated with the end user location.

Table 2-7 lists the columns on the Customer Account subtab.
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Table 2-7    Columns on the Customer Account Subtab

Column Description

Account Number Number used to identify a customer account.

Status Identifies the current status of the customer account.

Account Type Identifies the type of account this account represents.

Service Category Identifies the service category of the customer.

Account Name An individual's name or the company name.

Address Address of the customer.

Network System Subtab
The Network System subtab lists information about the network systems in which the network
components are associated with the end user location.

Table 2-8 lists the columns on the Network System subtab.

Table 2-8    Columns on the Network System Subtab

Column Description

Network System Type Specific type of the network system.

Configuration Type Name of the network system configuration type.

Short Name Short name of the network system.

Long Name Long name of the network system.

Description Description of the network system.

Status Status of the network system.

Component Type Type of pre-defined component contained in a network template.

Component Name Unique name of the component in the network system.

Service Request Subtab
The Service Request subtab lists information about the service requests associated with the
end user location.

• Service requests associated with the end user location

Table 2-9 lists the columns on the Service Request subtab.

Table 2-9    Columns on the Service Request Subtab

Column Description

Order Type The type of service request:

• ASR (Access Service Request)
• ISR (Internal Service Request)
• PSR (Product Service Request)
• LSR (Local Service Request)
• EWO (Engineering Work Order)
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Table 2-9    (Cont.) Columns on the Service Request Subtab

Column Description

Order Number Provider-assigned service order number for the requested service.

PON Indicates a provider-assigned identifier for the purchase order that authorized the service
request.

Related PON PON of another service request related to this service request.

Project Project associated with the service request.

Supplement Type Reason for issuing the supplement for an order. A supplement is any new iteration of an
access order. For example, 1 - Cancel, 2 - New due date, 3 - Other change, 4 - Correction.

Account Nbr Customer account number associated with the order.

Account Name Customer account name.

Responsible Party Person who is primarily responsible for an order.

Desired Due Date Date on which the customer wants the service to be activated, deactivated, or changed.

Dedicated Plant Subtab
The Dedicated Plant subtab provides information about the dedicated plant associated with
the end user location.

Table 2-10 lists the columns on the Dedicated Plant subtab.

Table 2-10    Columns on the Dedicated Plant Subtab

Column Description

Location Information End user location information related to the dedicated plant.

Cable Name Name of the cable whose pair is associated with the dedicated plant.

Pair/Fiber Number Cable pair/fiber number associated with the dedicated plant.

Equip Name Equipment associated with the dedicated plant.

Port Address Seq Port address of the equipment associated with the dedicated plant.

Resolution Options Area
The Resolution Options area provides options that enable you to select a primary end user
location/address to resolve inconsistencies related to end user locations. The primary end user
location/address is the only end user location/address that is retained after the resolution
process completes successfully. The Resolution Options area has the following options:

• Manually: Enables you to manually select the primary end user location or primary
address in the Selected Groups area by selecting the check box beside the end user
location or address that you want to set as the primary. This option is available for the
following scenarios:

– Multiple EULs having the same address. See "Resolving Multiple EULs Having the
Same Address" for more information.

– Multiple active addresses of the same address format per EUL. See "Resolving
Multiple Active Addresses of the Same Address Format per EUL" for more information.
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– Multiple EULs with the same address in MSAG and OBF structured formats. See
"Resolving Multiple EULs with the Same Address in MSAG and OBF Structured
Formats" for more information.

• Most Current Row: Automatically selects the end user location that has the latest
modified date as the primary address or primary end user location in the Selected Groups
area. This option is available only for the following scenarios:

– Multiple EULs having the same address. See "Resolving Multiple EULs Having the
Same Address" for more information.

– Multiple active addresses of the same address format per EUL. See "Resolving
Multiple Active Addresses of the Same Address Format per EUL" for more information.

• Maximum Entities: Automatically selects the end user location that has the maximum
number of impacted entities as the primary end user location in the Selected Groups
area. This option is available only for the following scenario:

– Multiple EULs having the same address. See "Resolving Multiple EULs Having the
Same Address" for more information.

• Resolve: Click to resolve inconsistencies related to end user locations.

For the resolution process to be successful, ensure the following in the Selected Groups
area before you click Resolve:

– Each group must have at least two rows to resolve inconsistencies related to end user
locations.

– You must select at least one row as the primary end user location or address in each
group.

After you click Resolve, the following occurs:

– A confirmation message is displayed that lists the total count of all the entities that will
be impacted by the resolve action. Click Yes to continue with the resolution process or
click No to cancel the resolution process.

Note

After you click Yes, the references of all the end user locations in a group are
moved to the primary end user location. You cannot undo this action.

– A summary of all the information related to the resolution process is logged. In
addition, all the details including success, failure, and manual messages related to the
resolution process for each scenario are displayed. See "Viewing Log Information" for
more information.

Preferences Tab
The Preferences tab has preferences that govern the functionality of the Address Correction
utility.
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Note

On the Preferences tab, click Save to save your settings for the preferences. If you
change the preference settings and navigate away from the Preferences tab without
saving your changes, a message is displayed that prompts you to save your settings.

Figure 2-3 shows the Preferences tab.

Figure 2-3    Preferences Tab

The Preferences tab has the following preferences:

• Update the references of additional addresses from the duplicate EUL to the primary
EUL

This preference is applicable to the following scenarios:

– Multiple EULs having the same address. See "Resolving Multiple EULs Having the
Same Address" for more information.

– Multiple EULs with the same address in MSAG and OBF structured formats. See
"Resolving Multiple EULs with the Same Address in MSAG and OBF Structured
Formats" for more information.

This preference has the following options:

– Update Nothing (This is the default): Does not update the references of additional
addresses from duplicate end user locations to the primary end user location.

Consider an example of the scenario where multiple end user locations have the same
address. In this example, one end user location with ID L1 has an address with ID A1
in MSAG structured format and the other end user location with ID L2 has that same
address with ID A1 in MSAG structured format. Suppose the end user location with ID
L2 has an additional address with ID A2 in SF1 structured format.

Table 2-11 lists the EUL information before the resolution process is started.
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Table 2-11    EUL Information Before Resolution

Location ID Address ID Structured Format Type

L1 A1 MSAG

L2 A1 MSAG

L2 A2 SF1

If you select the Update Nothing option, the resolution process does not update the
references of additional addresses from duplicate end user locations to the primary
end user location and retains the existing EUL information as is.

Table 2-12 lists the EUL information after the resolution process is completed.

Table 2-12    EUL Information After Resolution

Location ID Address ID Structured Format Type

L1 A1 MSAG

L2 A1 MSAG

L2 A2 SF1

– Update All: Updates the references of additional addresses from duplicate end user
locations to the primary end user location.

Consider an example of the scenario where multiple end user locations have the same
address. In this example, one end user location with ID L1, has an address with ID A1
in MSAG structured format and the other end user location with ID L2 has that same
address with ID A1 in MSAG structured format. Suppose the end user location with ID
L2 has an additional address with ID A2 in SF1 structured format.

Table 2-13 lists the EUL information before the resolution process is started.

Table 2-13    EUL Information Before Resolution

Location ID Address ID Structured Format Type

L1 A1 MSAG

L2 A1 MSAG

L2 A2 SF1

In this example, the end user location with ID L1 having the address with ID A1 in
MSAG structured format is selected as the primary; as a result, end user location with
ID L2 having that same address with ID A1 in MSAG structured format is moved into
the primary end user location with ID L1. If you select the Update All option, the
resolution process also moves address with ID A2 in SF1 structured format located at
end user location with ID L2 into the primary end user location with ID L1.

Table 2-14 lists the EUL information after the resolution process is completed.

Table 2-14    EUL Information After Resolution

Location ID Address ID Structured Format Type

L1 A1 MSAG
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Table 2-14    (Cont.) EUL Information After Resolution

Location ID Address ID Structured Format Type

L1 A2 SF1

• Update the address data in E911 records

This preference is applicable to the scenario Multiple active addresses of the same
address format per EUL. See "Resolving Multiple Active Addresses of the Same Address
Format per EUL" for more information.

This preference has the following options:

– No (This is the default): The primary end user location's address information is not
updated in the E911 records. The end user location's address and the end user
location address information in the E911 records may differ after the resolution
process. You may have to do some manual steps displayed in the log to correct this
inconsistency. See serial number 11 in Table 6-3 for more information.

– Yes: The primary end user location's address information is updated in the E911
Records. The end user location's address and the end user location address
information in the E911 records within MSS remains the same; however, it may differ in
third-party systems after the resolution process. You may have to do some manual
steps displayed in the log to correct this inconsistency. See serial number 12 in 
Table 6-3 for more information.

• Merge the Equipment Structure item hierarchy from the duplicate EUL to the primary
EUL

This preference is applicable to the following scenarios:

– Multiple EULs having the same address. See "Resolving Multiple EULs Having the
Same Address" for more information.

– Multiple EULs with the same address in MSAG and OBF structured formats. See
"Resolving Multiple EULs with the Same Address in MSAG and OBF Structured
Formats" for more information.

This preference has the following options:

– No (This is the default): Does not merge the equipment structure items hierarchy
(including all the equipment under each structure item) from the duplicate end user
location to the primary end user location. See serial number 6 in Table 6-3 for more
information.

– Yes: Merges the equipment structure items hierarchy (including all the equipment
under each structure item) from the duplicate end user location to the primary end user
location. See serial number 6 in Table 6-3 for more information.

Consider an example in which a primary end user location (END USER LOCATION
PRIMARY), has equipment (EQUIPMENT 01) installed in the equipment structure item
hierarchy as shown in Figure 2-4. In addition, there are two duplicate end user
locations (END USER LOCATION DUPLICATE 01 and END USER LOCATION
DUPLICATE 02) that have equipment (EQUIPMENT 02 and EQUIPMENT 03) installed
in the equipment structure item hierarchy as shown in Figure 2-4.
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Figure 2-4    Before the Equipment Structure Item Hierarchy Is Merged

In this example, when you set the Merge the Equipment Structure item hierarchy
from the duplicate EUL to the primary EUL preference to Y, the Address Correction
utility merges the equipment structure item hierarchies of the duplicate end user
locations, END USER LOCATION (DUPLICATE 01) and END USER LOCATION
(DUPLICATE 02), into the equipment structure item hierarchy of the primary end user
location, END USER LOCATION (PRIMARY), as shown in Figure 2-5.
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Figure 2-5    After the Equipment Structure Item Hierarchy Is Merged

• Update EUL details for ASR(including CABS)/LSR orders

This preference is applicable to the following scenarios:

– Multiple EULs having the same address. See "Resolving Multiple EULs Having the
Same Address" for more information.

– Multiple active addresses of the same address format per EUL. See "Resolving
Multiple Active Addresses of the Same Address Format per EUL" for more information.

This preference has the following options:

– Update Nothing (This is the default): Does not update the end user location
information for any of the ASR (including CABS) and LSR orders, regardless of their
order status.

– Update All: Updates the EUL info for all the ASR (including CABS) and LSR orders,
regardless of their order status.

– Update orders with no provisioning plan assigned: Updates the EUL info only for
the ASR (including CABS) and LSR orders that have no provisioning plan assigned.
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MetaSolv Solution Utilities Secondary Toolbar
In MetaSolv Solution Utilities, the secondary toolbar has the following buttons:

• Export: Enables you to export the data in the Available Groups area. See "Exporting
Available Groups Data" for more information.

• View Log: Enables you to view the log information for the jobs that you run to resolve
inconsistencies related to end user locations for each scenario. See "Viewing Log
Information" for more information.

Exporting Available Groups Data
On the Results tab, you can export data in the Available Groups area into a file and save the
file to any location. You can save the exported data in the following recommended formats:

• CSV (.csv)

• CSV (.csv) with header

• Microsoft Excel (.xls) with header

• Microsoft Excel (.xls)

To export the available groups data:

1. Log in to the MetaSolv Solution Utilities.

2. From the Options menu, select Address Correction Utility, then Address Correction.

The Address Correction utility is displayed.

3. On the Criteria tab, specify your search criteria and click Search.

The search results are displayed in the Available Groups area of the Results tab.

4. On the secondary toolbar, click Export.

The Save As dialog box is displayed.

5. In the File name field, specify a name for the file.

6. From the Save in list, navigate to the location where you want to save the file.

7. From the Save as type list, select the file format.

8. Click Save.
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3
Resolving Multiple EULs Having the Same
Address

This chapter demonstrates how to use the Address Correction utility to resolve multiple end
user locations (EULs) that have the same address.

Scenario Overview
In this scenario, multiple end user locations with IDs L1, L2, and L3 have the same address
with ID A1. You can select one end user location (for example, with ID L1) as the primary. After
you resolve, only the primary end user location with ID L1 is retained and all the remaining end
user locations (with IDs L2 and L3) are replaced with the primary end user location with ID L1
that has the address with ID A1.

The following preferences govern this scenario:

• Update the references of additional addresses from the duplicate EUL to the primary EUL

• Merge the Equipment Structure item hierarchy from the duplicate EUL to the primary EUL

• Update EUL details for ASR(including CABS)/LSR orders

Resolving Multiple EULs Having Same Address
To resolve multiple end user locations having the same address:

1. Run the Address Correction utility. See "Running the Address Correction Utility" for more
information.

2. Click the Criteria tab.

3. Under the I want to find area, select the Multiple EULs having same address option.

4. From the Country list, select a country.

5. From the Format list, select an address structured format.

6. Specify your search criteria in the Network Loc Name, End User Loc Name, or any of the
address fields and click the fields where you want to specify the partial names using wild
cards and click Set Criteria. See "Setting the Search Criteria" for more information.

7. In the Limit Number Found To field, enter the maximum number of records to be
retrieved for the search. See "Setting the Maximum Number of Records to Be Retrieved"
for more information.

8. Click Search.

The Address Correction utility searches for all the groups of end user locations that have
the same address based on the specified search criteria. The Results tab displays multiple
end user locations grouped by address ID in the Available Groups area.

Consider an example where the end user locations and addresses exist with IDs as shown
in Table 3-1.
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Table 3-1    End User Locations and Addresses

End User Location Name Location ID Address ID

EUL1 L1 A1

EUL2 L2 A1

EUL3 L3 A1

EUL4 L4 A2

If you specify EUL1 in the End User Loc Name field, the Address Correction utility first
searches for the address to which L1 belongs, and then it retrieves all the duplicate end
user locations that belong to that address.

In this example, EUL1 belongs to the location with ID L1 and to the address with ID A1;
therefore, the Address Correction utility retrieves the following end user locations that
belong to A1 and displays them in the Available Groups area on the Results tab:

• L1

• L2

• L3

In this example, EUL4 belonging to the location with ID L4 is not retrieved in the search
results because it belongs to the address with ID A2.

9. (Optional) On the secondary toolbar, click Export to export the data displayed in the
Available Groups area. See "Exporting Available Groups Data" for more information.

10. Do one of the following:

• Select the end user locations/groups of end user locations you want to resolve and
click the single arrow button, which moves the selected end user locations/groups of
end user locations from the Available Groups area to the Selected Groups area.

• Click the double arrow button to move all the end user locations from the Available
Groups area to the Selected Groups area.

11. In the Resolution Options area, select one of the following options depending on how you
want to resolve multiple end user locations that have the same address:

• Manually

• Most Current Row

• Maximum Entities

See "Resolution Options Area" for more information.

12. Click Resolve.

Note

The amount of time taken by the Address Correction utility to complete the
resolution process depends on the number of rows in the Selected Groups area.

A confirmation message is displayed that lists the total count of all the entities that will be
impacted by the resolve action.

13. Click Yes.

You cannot undo this action.
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A unique identifier (Job ID) is generated for the group of data in the Selected Groups area
whose data inconsistencies are being resolved. This identifier is used to compile log
information in the View Log window. See "Viewing Log Information" for more information.

The references of all the end user locations are moved to the primary end user location.
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4
Resolving Multiple Active Addresses of the
Same Address Format per EUL

This chapter demonstrates how to use the Address Correction utility to resolve the scenario in
which multiple active addresses of the same format exist in an end user location (EUL).

Scenario Overview
In this scenario, an end user location with ID L1 has multiple active addresses with IDs A1, A2,
and A3 of the same structured format. You can select one active address (for example, with ID
A1) as the primary. After you resolve, only the primary active address with ID A1 is retained
and all the references of the remaining addresses (with IDs A2 and A3) are replaced with the
primary active address with ID A1 at the end user location with ID L1.

The following preferences govern this scenario:

• Update the address data in E911 records

• Update EUL details for ASR(including CABS)/LSR orders

Resolving Multiple Active Addresses of the Same Address
Format Per EUL

To resolve active addresses of the same address format per end user location:

1. Run the Address Correction utility. See "Running the Address Correction Utility" for more
information.

2. Click the Criteria tab.

3. Under the I want to find area, select the Multiple active address per EUL per address
structured format option.

4. From the Country list, select a country.

5. From the Format list, select an address structured format.

Specifying an address format is mandatory for this scenario. The Query across all
Address Formats option is not available for this scenario.

6. Specify your search criteria in the Network Loc Name, End User Loc Name, or any of the
address fields and click the fields where you want to specify the partial names using wild
cards and click Set Criteria. See "Setting the Search Criteria" for more information.

7. In the Limit Number Found To field, enter a value. This value determines the maximum
number of records to be retrieved for the search. See "Setting the Maximum Number of
Records to Be Retrieved" for more information.

8. Click Search.

The Address Correction utility searches for all the end user locations with multiple active
addresses of the same structured format. The Results tab displays multiple active
addresses grouped by end user location ID in the Available Groups area.
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Consider an example where the active addresses and end user locations exist with IDs as
shown in Table 4-1.

Table 4-1    Multiple Active Addresses Per End User Location

Address ID Location ID Structured Format

A1 L1 MSAG

A2 L1 MSAG

A3 L1 MSAG

A1 L2 MSAG

For example, if you enter the following as your search criteria:

• From the Format list, select North American Master Street Address Guide.

• In the address fields, specify the address for A1.

The Address Correction utility first searches for the end user location to which A1 belongs,
and then it retrieves all the active addresses that belong to that end user location.

In this example, A1 belongs to the to the end user location with ID L1 with MSAG
structured format; therefore, the Address Correction utility retrieves the following active
addresses of MSAG structured format that belong to end user location with ID L1 and
displays them in the Available Groups area on the Results tab:

• A1

• A2

• A3

In this example, the address with ID A1 belonging to end user location with ID L2 is not
retrieved in the search results because L2 does not have multiple active addresses of
MSAG structured format.

9. (Optional) On the secondary toolbar, click Export to export the data displayed in the
Available Groups area. See "Exporting Available Groups Data" for more information.

10. Do one of the following:

• Select the addresses/groups of addresses you want to resolve and click the single
arrow button, which moves the selected addresses/groups of addresses from the
Available Groups area to the Selected Groups area.

• Click the double arrow button to move all the addresses from the Available Groups
area to the Selected Groups area.

11. In the Resolution Options area, select one of the following options depending on how you
want to resolve multiple active addresses of the same address format per end user
location:

• Manually

• Most Current Row

See "Resolution Options Area" for more information.

12. Click Resolve.
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Note

The amount of time taken by the Address Correction utility to complete the
resolution process depends on the number of rows in the Selected Groups area.

A confirmation message is displayed that lists the total count of all the entities that will be
impacted by the resolve action.

13. Click Yes.

You cannot undo this action.

A unique identifier (Job ID) is generated for the group of data in the Selected Groups area
whose data inconsistencies are being resolved. This identifier is used to compile log
information in the View Log window. See "Viewing Log Information" for more information.

The references of all the active addresses are moved to the primary address.
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5
Resolving Multiple EULs with the Same
Address in MSAG and OBF Structured
Formats

This chapter demonstrates how to use Address Correction utility to resolve the scenario in
which multiple end user locations (EUL) have the same address in Master Street Address
Guide (MSAG) and Ordering and Billing Forum (OBF) structured formats.

Scenario Overview
In this scenario, two end user locations have the same address components in different
structured formats. One end user location with ID L1 has an address in MSAG structured
format and the other end user location with ID L2 has that same address in OBF structured
format.

By default, the end user location with ID L2 having the address in OBF structured format is
selected as the primary. After you resolve, only the primary end user location with ID L2 is
retained and the end user location with ID L1 having the address in MSAG structured format is
merged with the primary end user location with ID L2.

Note

In this scenario, the Address Correction utility always selects the end user location
having the address in OBF structured format as the primary by default.

The following preferences govern this scenario:

• Update the references of additional addresses from the duplicate EUL to the primary EUL

• Merge the Equipment Structure item hierarchy from the duplicate EUL to the primary EUL

Resolving Multiple EULs with the Same Address in MSAG and
OBF Structured Formats

To resolve multiple end user locations with the same address in MSAG and OBF structured
formats:

1. Run the Address Correction utility. See "Running the Address Correction Utility" for more
information.

2. Click the Criteria tab.

3. Under the I want to find area, select the Multiple EULs having same address option.

4. Specify your search criteria in the Network Loc Name, End User Loc Name, or any of the
address fields.
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5. From the Country list, select United States.

United States is the only option available in the Country list for this scenario.

6. From the Format list, select one of the following:

• North American Master Street Address Guide

• OBF Service Address Location Information

The Address Correction utility searches for addresses in both the MSAG and OBF
structured formats, irrespective of the format you select from the Format list.

7. (Optional) Click the field where you want to specify the partial name and click Set Criteria.

The Set Selection Criteria window is displayed that lets you specify partial names using
wild cards if you do not know the full name to specify in your search criteria. See "Setting
the Search Criteria" for more information.

8. In the Limit Number Found To field, specify a value. This value determines the maximum
number of records to be retrieved for the search. See "Setting the Maximum Number of
Records to Be Retrieved" for more information.

9. Click Search.

The Address Correction utility searches for all the groups of end user locations that have
the same address in MSAG and OBF structured formats. The Results tab displays
multiple end user locations grouped by address ID in the Available Groups area.

Consider an example where the end user locations and addresses exist with IDs as shown
in Table 5-1.

Table 5-1    End User Locations and Addresses

Address Address ID Location ID Structured Formats

23, TEST ST, TX, 23456 A1 L1 MSAG

23, TEST ST, TX, 23456 A2 L2 OBF

25, TEST ST, TX, 23457 A3 L3 MSAG

24, TEST ST, TX, 23456 A4 L4 OBF

If you select TX form the State list, the Address Correction utility searches for the end user
locations that have matching address components. In this example, the Address
Correction utility retrieves the following end user locations that have matching address
components (23, TEST ST, TX, 23456) and displays them in the Available Groups area
on the Results tab:

• End user location with ID L1 that has address with ID A1 in MSAG structured format

• End user location with ID L2 that has address with ID A2 in OBF structured format

In this example, the following end user locations are not retrieved in the search results
because they do not have matching address components:

• End user location with ID L3 that has address with ID A3 in MSAG structured format

• End user location with ID L4 that has address with ID A4 in OBF structured format

Consider another example where the end user locations and addresses exist with IDs as
shown in Table 5-2.
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Table 5-2    End User Locations and Addresses

Address Address ID Location ID Structured Formats

23, TEST ST, TX, 23456 A1 L1 MSAG

23, TEST ST, TX, 23456 A2 L2 OBF

25, TEST ST, TX, 23457 A3 L3 MSAG

24, TEST ST, TX, 23456 A4 L4 OBF

26, TEST ST, TX, 55555 A5 L1 OBF

If you select TX form the State list, the Address Correction utility searches for the end user
locations that have matching address components. In this example, the Address
Correction utility does not display any results in the Available Groups area on the Results
tab, because even though the address components (23, TEST ST, TX, 23456) of the end
user locations with ID L1 and ID L2 are matching, an additional address with ID A5 exists
in OBF structured format at the end user location with ID L1.

10. (Optional) On the secondary toolbar, click Export to export the data displayed in the
Available Groups area. See "Exporting Available Groups Data" for more information.

11. Do one of the following:

• Select the end user locations you want to resolve and click the single arrow button,
which moves the selected end user locations from the Available Groups area to the
Selected Groups area.

• Click the double arrow button to move all the end user locations from the Available
Groups area to the Selected Groups area.

12. In the Selected Groups area, the end user location having the address in OBF structured
format is selected as the primary end user location by default.

13. Click Resolve.

Note

The amount of time taken by the Address Correction utility to complete the
resolution process depends on the number of rows in the Selected Groups area.

A confirmation message is displayed that lists the total count of all the entities that will be
impacted by the resolve action.

14. Click Yes.

You cannot undo this action.

A unique identifier (Job ID) is generated for the group of data in the Selected Groups area
whose data inconsistencies are being resolved. This identifier is used to compile log
information in the View Log window. See "Viewing Log Information" for more information.

The end user location having the address in MSAG format is merged with the end user
location having the address in OBF structured format (primary).
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6
Viewing Log Information

This chapter provides information about the View Log window in the Address Correction utility.

View Log Window
The View Log window displays the log information for the jobs that you run to resolve
inconsistencies related to end user locations. This information is logged in the
ASAP.ACU_LOG table in the MSS database.

The View Log window has the following sections:

• View Log Search Section

• View Log Results Section

View Log Search Section
The View Log Search section enables you to search for the required log information.

Figure 6-1 shows the View Log Search section.

Figure 6-1    View Log Search Section

Table 6-1 lists the fields in the View Log Search section.

Table 6-1    Fields in the View Log Search Section

Field Description

Job Id Unique identifier for the job.

Log Details Enables you to specify wild cards to search for log information. See Table 2-2 for more
information on the wild cards you can specify in this field.

From Date The date from which to search for the log information. Defaults to a date one week before the
current date.

Through Date The date until which to search for the log information. Defaults to the current date.
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Table 6-1    (Cont.) Fields in the View Log Search Section

Field Description

Status Status of the job:

• Pass: Indicates that the job ran successfully and all the inconsistencies related to end
user locations were resolved in the selected group.

• Fail: Indicates that the job did not run successfully and processing was halted for at
least one of the duplicate end user locations/addresses. For example, if the duplicate
end user location has a network location alias in the scenario where multiple end user
locations have the same address, the processing stops for that particular end user
location but the job continues processing for the remaining duplicate end user locations
and the status of the job is displayed as Fail.

• Manual: Indicates that the job ran successfully and manual steps may be required to
reconcile data in the MSS application or third-party systems. For example, if the location
name is not updated in the Connection Design Window - CLR/DLR Design view, the
status of the job is displayed as Manual, which indicates that you must do some manual
steps to update the location in the MSS application.

Search Click to retrieve the log information that matches the specified search criteria.

Purge Before (Days) Data older than the number of days specified in this field is purged. Defaults to 30.

Purge Click to purge the log information. You cannot undo this action.

View Log Results Section
The View Log Results section displays the log information that you search for.

Figure 6-2 shows the View Log Results section.

Figure 6-2    View Log Results Section
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Table 6-2 lists the columns in the View Log Results section.

Table 6-2    Columns in the View Log Results Section

Column Description

Job Id ID of the job that is run to resolve inconsistencies related to end user locations.

Sequence Sequence of steps within a job.

Start Date Start date and time of the job.

End Date End date and time of the job.

Status Status of the job ID:

• Pass
• Fail
• Manual
See Table 6-3 for a list of ACU log error messages based on the status of the job ID.

User Id ID of the user that runs the job.

The View Log Results section displays the following information for each job in the order listed:

• The job ID.

• The specific option you select for every job under the I want to find area on the Criteria
tab.

• The resolution option that you select in the Resolution Options area on the Results tab.

• All the preferences that you set on the Preferences tab.

• All the primary end user locations/addresses.

• All the duplicate end user locations/addresses.

• Lists the modified tables for each duplicate end user location/address that is processed.

Table 6-3 lists the messages that are displayed in the View Log Results section.
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Table 6-3    ACU Log Messages

Sr. No. Job ID
Status

Message Possible Cause Solution

1 Fail
Duplicate End User Location has 
active addresses of other 
format(s):
END_USER_LOCATION_ID: EUL_ID
END_USER_LOCATION_NAME: EUL_Name
LOCATION_ID: Loc_ID
Processing halted for this end 
user location.

where:

• EUL_ID is the end user location ID
of the duplicate end user location.

• EUL_Name is the end user location
name of the duplicate end user
location.

• Loc_ID is the location ID of the
duplicate end user location.

Applicable Scenarios:
• Scenario 11

• Scenario 33

The Update the references of
additional addresses from the
duplicate EUL to the primary
EUL preference is set to N and
an additional address exists at
the duplicate end user location.

Example:
One end user location with ID L1
has an address with ID A1 in
MSAG structured format and the
other end user location with ID
L2 has that same address with
ID A1 in MSAG structured
format. The end user location
with ID L2 has an additional
address with ID A2 in SF1
structured format.

See Table 2-11 for the sample
data.

Do one of the following:

• Set the Update the
references of
additional
addresses from
the duplicate EUL
to the primary EUL
preference to Y.

• Remove the
additional
addresses at the
duplicate end user
location.

2 Fail
Network Location Alias found for 
the end user location:
END_USER_LOCATION_ID: EUL_ID
END_USER_LOCATION_NAME: EUL_Name
LOCATION_ID: Loc_ID
Processing halted for this end 
user location.
You can delete the Network 
Location Alias from
"Location and Geography Setup > 
Network Location" to process
this duplicate end user location.

where:

• EUL_ID is the end user location ID
of the duplicate end user location.

• EUL_Name is the end user location
name of the duplicate end user
location.

• Loc_ID is the location ID of the
duplicate end user location.

Applicable Scenarios:
• Scenario 11

• Scenario 33

A network alias exists for the
duplicate end user location.

Delete the network alias
for the duplicate end
user location in the MSS
application.
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Table 6-3    (Cont.) ACU Log Messages

Sr. No. Job ID
Status

Message Possible Cause Solution

3 Fail
Network Areas 
Network_Area_Primary and 
Network_Area_Duplicate are 
different
for the primary and duplicate 
locations.
Processing halted for this end 
user location.
Please ensure the network area 
and the TN/Data switches are the 
same to process this end user 
location.

where:

• Network_Area_Primary is the
network area name associated with
the primary end user location.

• Network_Area_Duplicate is the
network area name associated with
the duplicate end user location.

Applicable Scenarios:
• Scenario 11

• Scenario 33

Different network areas are
associated with the primary and
duplicate end user locations.

Example:
One end user location with ID L1
has network area NA1 and the
other end user location with ID
L2 has network area NA2.

Associate the same
network area to the
primary and the
duplicate end user
locations in the MSS
application.

4 Fail
Data Switches Data_Switch_Primary 
and Data_Switch_Duplicate are 
different
for the primary and duplicate 
locations.
Processing halted for this end 
user location.
Please ensure the network area 
and the TN/DATA switches are the
same to process this end user 
location.

where:

• Data_Switch_Primary is the data
switch associated with the primary
end user location.

• Data_Switch_Duplicate is the data
switch associated with the duplicate
end user location.

Applicable Scenarios:
• Scenario 11

• Scenario 33

Different data switches are
associated with the primary and
duplicate end user locations.

Example:
One end user location with ID L1
has data switch D1 and the
other end user location with ID
L2 has data switch D2.

Associate the same data
switches to the primary
and the duplicate end
user locations in the
MSS application.
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Table 6-3    (Cont.) ACU Log Messages

Sr. No. Job ID
Status

Message Possible Cause Solution

5 Fail
TN Switches TN_Switch_Primary and 
TN_Switch_Duplicate
are different for the primary and 
duplicate locations.
Processing halted for this end 
user location.
Please ensure the network area 
and the TN/Data switches are the
same to process this end user 
location.

where:

• TN_Switch_Primary is the TN switch
associated with the primary end
user location.

• TN_Switch_Duplicate is the TN
switch associated with the duplicate
end user location.

Applicable Scenarios:
• Scenario 11

• Scenario 33

Different TN switches are
associated with the primary and
duplicate end user locations.

Example:
One end user location with ID L1
has TN switch T1 and the other
end user location with ID L2 has
TN switch T2.

Associate the same TN
switches to the primary
and the duplicate end
user locations in the
MSS application.
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Table 6-3    (Cont.) ACU Log Messages

Sr. No. Job ID
Status

Message Possible Cause Solution

6 Fail
Same Structure Item exists in the 
Equipment Inventory
for both the end user locations.
END_USER_LOCATION_ID: 
EUL_ID_Primary
END_USER_LOCATION_NAME: 
EUL_Name_Primary
LOCATION_ID: Loc_ID_Primary
END_USER_LOCATION_ID: 
EUL_ID_Duplicate
END_USER_LOCATION_NAME: 
EUL_Name_Duplicate
LOCATION_ID: Loc_ID_Duplicate
The Preference to merge the 
Equipment Structure Item is set 
to "N". 
Please set the preference to "Y" 
or navigate to
Inventory Management > Equipment 
Inventory in MSS application
to take necessary action.
Processing halted for this 
LOCATION_ID.

where:

• EUL_ID_Primary is the end user
location ID of the primary end user
location.

• EUL_Name_Primary is the end user
location name of the primary end
user location.

• Loc_ID_Primary is the location ID of
the primary end user location.

• EUL_ID_Duplicate is the end user
location ID of the duplicate end user
location.

• EUL_Name_Duplicate is the end
user location name of the duplicate
end user location.

• Loc_ID_Duplicate is the location ID
of the duplicate end user location.

Applicable Scenarios:
• Scenario 11

• Scenario 33

The Merge the Equipment
Structure item hierarchy from
the duplicate EUL to the
primary EUL preference is set
to N and the same equipment
structure item hierarchy exists
on both primary and duplicate
end user locations.

See Figure 2-4 for an example of
the equipment structure item
hierarchy.

Do one of the following:

• Set the Merge the
Equipment
Structure item
hierarchy from the
duplicate EUL to
the primary EUL
preference to Y.

• In the MSS
application, navigate
to Inventory
Management -
Equipment
Inventory and
perform the
necessary action.
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Table 6-3    (Cont.) ACU Log Messages

Sr. No. Job ID
Status

Message Possible Cause Solution

7 Fail
Error retrieving network area.
Multiple switch network areas 
exist in the database.
Only one switch network area can 
be assigned to an end user 
location.

Applicable Scenarios:
• Scenario 11

• Scenario 22

• Scenario 33

Multiple network areas exist for
an end user location.

Fix the data and rerun
the Address Correction
utility.

8 Fail
Error retrieving TN switch.
Multiple TN Switches exist in the 
database.
Only one TN Switch can be 
assigned to an end user location.

Applicable Scenarios:
• Scenario 11

• Scenario 22

• Scenario 33

Multiple TN switches exist for an
end user location.

Fix the data and rerun
the Address Correction
utility.

9 Fail
Error retrieving Data Switch.
Multiple Data Switches exist in 
the database.
Only one Data Switch can be 
assigned to an end user location.

Applicable Scenarios:
• Scenario 11

• Scenario 22

• Scenario 33

Multiple data switches exist for
an end user location.

Fix the data and rerun
the Address Correction
utility.

10 Manual
The location information is not 
updated in the CLR/DLR Design 
in Connection Design.
You may want to navigate to 
Inventory Management > Connection 
Design
> CLR/DLR Design in the MSS 
application and reconcile the
assignment information using
Reconcile Assignments link under 
Actions section.

Applicable Scenarios:
• Scenario 11

• Scenario 33

The location name in the design
lines of the CLR/DLR Design
view of the Connection Design
window is different from the
duplicate end user location
name.

After the resolution
process is completed, in
the MSS application,
navigate to Inventory
Management -
Connection Design -
CLR/DLR Design and
click the Reconcile
Assignments link under
Actions section to
reconcile the assignment
information.
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Table 6-3    (Cont.) ACU Log Messages

Sr. No. Job ID
Status

Message Possible Cause Solution

11 Manual
E911 data Updates: 
Address details of the end user 
location are not updated in
E911_EXTRACT for the Telephone 
numbers.
Tel No.
House Nbr:  
House Nbr Suffix:
Pre Directional: 
Street Name: 
Street Suffix: 
Post Directional: 
Community Name: 
Postal Code: 
Country ID: 
State/Province:
You may want to update the 
E911_EXTRACT with the updated
end user location address and
resend the updated E911 
information via a PSR order.

This message lists the telephone
numbers and their address details.

Applicable Scenario:
• Scenario 22

The Update the address data
in E911 records preference is
set to N.

In the MSS application,
create a change PSR
order for the impacted
telephone numbers and
complete the process for
E911.
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Table 6-3    (Cont.) ACU Log Messages

Sr. No. Job ID
Status

Message Possible Cause Solution

12 Manual
E911 data Updates: 
Updated the address details in 
E911_EXTRACT for the Telephone 
numbers.
Tel No.
House Nbr: 
House Nbr Suffix:
Pre Directional: 
Street Name: 
Street Suffix: 
Post Directional: 
Community Name: 
Postal Code: 
Country ID: 
State/Province:
You may want to resend the 
updated E911 information by 
navigating to 
Order Management Setup > E911 
Records or via a PSR order.

This message lists the telephone
numbers and their address details.

Applicable Scenario:
• Scenario 22

The Update the address data
in E911 records preference is
set to Y. As a result, the address
information in the E911 records
corresponding to the duplicate
end user location is updated
with the primary end user
location's address.

The end user location's
address and address
information in the E911
records within the MSS
application is the same.
However, it may differ in
third-party systems. To
resolve this issue do one
of the following:

• In the MSS
application, navigate
to Order
Management Setup
- E911 Records and
do the required
changes.

• In MSS application,
create a change
PSR order for the
impacted telephone
numbers and
complete the
process for E911.

13 Manual
There are n active rows for the 
format Address_Format.
Please run Option 2 for the End 
User Location EUL_Name_Primary.

where:

• n is the total number of active
addresses at the primary end user
location.

• Address_Format is the address
format of the active addresses at the
primary end user location.

• EUL_Name_Primary is the end user
location name of the primary end
user location.

Applicable Scenarios:
• Scenario 11

• Scenario 22

• Scenario 33

The end user location has
multiple active addresses of the
same structured format.

Example:
The primary end user location
with ID L1 has an address with
ID A1 of MSAG structured
format. The duplicate end user
location with ID L2 has an
address with ID A1 of MSAG
structured format. In addition,
the primary end user location
with ID L1 has an additional
address with ID A2 of MSAG
structured format.

After the resolution process is
completed, the primary end user
location with ID L1 now has
addresses with IDs A1 and A2 of
MSAG structured format.

On the Criteria tab,
select the Multiple
active address per EUL
per address structured
format option to search
for and resolve multiple
active addresses of the
same address structured
format at the same end
user location.

See "Resolving Multiple
Active Addresses of the
Same Address Format
per EUL" for more
information.
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Table 6-3    (Cont.) ACU Log Messages

Sr. No. Job ID
Status

Message Possible Cause Solution

14 Manual
The address for the service 
location 
dup_end_user_location_name is 
changed. 
The directory listing of the 
below items for the customer 
accounts may not be updated with 
the primary location address.
1. LINEDIR item 
line_directory_item, exists on the
customer Account Number 
cust_acct_nbr 
Company Name: company_name Name: 
account_name
in status item_status
2. LINEDIR item 
line_directory_item, exists on 
the 
customer Account Number 
cust_acct_nbr 
Company Name: company_name Name: 
account_name
in status item_status
You may want to create a change 
PSR order for the items which 
are pending/In-Service to make 
the necessary changes for
the directory listing address 
information.

where:

• dup_end_user_location_name is the
name of the duplicate end user
location.

• line_directory_item is the line
directory product's name.

• cust_acct_nbr is the customer
account number.

• company_name is the name of the
company; displayed if the service
category is Business.

• account_name is the customer
name/company name; displayed if
the service category is Residential
or Business.

• item_status is the status of the Line
item.

Applicable Scenario:
• Scenario 22

The address that is being
modified has a directory listing
product.

In the MSS application,
create a change PSR
order for the impacted
item whose directory
listing you want to
update with the primary
location address.

1 Scenario 1: Multiple end user locations having the same address.
2 Scenario 2: Multiple active addresses of same address format at the same end user location.
3 Scenario 3: Multiple end user locations having the same address in MSAG and OBF structured formats.
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Searching for Log Information
To search for log information:

1. Do one of the following:

• On the secondary toolbar, click the View Log button.

• From the Options menu, select View Log.

The View Log Search section is displayed.

2. In the Job Id field, enter the unique identifier for the job.

3. In the Log Details field, enter any keyword pertaining to the log information that you want
to search.

4. In the From Date field, enter the date from which you want to search the log information.

5. In the Through Date field, enter the date until which you want to search the log
information.

6. From the Status list, select any one of the following job status:

• Pass

• Fail

• Manual

7. Click Search.

The log information is displayed in the View Log Results section.

Purging Log Information
To purge the log information:

1. On the secondary toolbar, click the View Log button. Alternatively, from the Options
menu, select View Log.

The View Log Search section is displayed.

2. In the Purge Before (Days) field, specify a value. The default value is 30.

3. Click Purge.

A confirmation message is displayed.

4. Click Yes.

If you specify a value in the Purge Before (Days) field, the log information older than the
specified number of days is purged. If you do not specify any value in the Purge Before
(Days) field, the log information older than the system's current date is permanently
deleted from the ASAP.ACU_LOG table in the MSS database.
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A
MSS User Interface Impacted by the
Resolution Process

This appendix provides information on Oracle Communications MetaSolv Solution (MSS) user
interface (UI) windows, which are impacted during the Address Correction Utility resolution
process.

Table A-1 lists the MSS UI that may be impacted after the resolution processing by the
Address Correction utility based on the resolution scenario.

Table A-1    MSS UI Impacted After Resolution Process

Subsystem MSS UI Impacted Navigation Applicable
Scenario

Connection
Design

Locations tab In the Connection Design window, under Provisioning, click the
Additional Detail link, and then click the Locations tab.

Scenario 11

Scenario 22

Scenario 33

Connection
Design

Connection Design
Search window

On the navigation bar, select Inventory Management, and then
click Connection Design.

Scenario 11

Scenario 33

Connection
Design

Equipment
Assignments tab

In the Connection Design window, under Provisioning, click the
CLR/DLR Design link, and then click the Reconcile
Assignments link. In the Connection Reconciliation window, click
the Equipment Assignments tab.

Scenario 11

Scenario 33

Connection
Design

Connection
Summary view

In the Connection Design window, click the Connection
Summary link.

Scenario 11

Scenario 22

Scenario 33

Connection
Design

Print Preview
window

In the Connection Design window, from the Outputs menu, select
Preview CLR or Preview CLR/DLR.

In the Trouble Ticket Queue window or the Trouble Ticket Search
window, click the Service Item tab, and then click View Design.

Scenario 11

Scenario 22

Scenario 33

Connection
Design

CLR/DLR Design
view

In the Connection Design window, under Provisioning, click the
CLR/DLR Design link.

Scenario 11

Scenario 33

Connection
Design

Schematic Design
view

In the Connection Design window, under Provisioning, click the
Schematic Design link.

Scenario 11

Scenario 22

Scenario 33

Connection
Design

Activation Report In the Connection Design window, from the Outputs menu, select
Activation Report.

In the Trouble Ticket Queue window or the Trouble Ticket Search
window, click the Service Item tab, and then click View
Activation Rpt.

Scenario 11

Scenario 22

Scenario 33

Product
Service
Request

Service Location In the Product Service Request window, under Order
Maintenance, click the Services link.

Scenario 11

Scenario 22

Scenario 33
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Table A-1    (Cont.) MSS UI Impacted After Resolution Process

Subsystem MSS UI Impacted Navigation Applicable
Scenario

Product
Service
Request

PRILOC/SECLOC
Info tab

In the Product Service Request window, under Order
Maintenance, click the Services link. Expand the product
hierarchy, select a service item, and then click the PRILOC/
SECLOC Info tab. The PRILOC/SECLOC Info tab is displayed
only for the products that have information about primary location
and secondary location.

Scenario 11

Scenario 22

Scenario 33

Product
Service
Request

Summary Info tab In the Product Service Request window, under Order
Maintenance, click the Services link. Expand the product
hierarchy, select a service item, and then click the Summary Info
tab.

Scenario 11

Scenario 22

Scenario 33

Product
Service
Request

Do you want to
include any of these
existing locations?
window.

In the PSR Ordering Dialog, click the Existing Locations link. Scenario 11

Scenario 22

Scenario 33

Product
Service
Request

Is the list of locations
correct? window

In the PSR Ordering Dialog, click the List of Locations link. Scenario 11

Scenario 22

Scenario 33

Product
Service
Request

Product History tab In the Service Request Search window, click the Product History
tab.

Scenario 11

Scenario 22

Scenario 33

Product
Service
Request

New PSR Order
from Existing PSR
Order

In the Service Request Search window, select a service request.
From the File menu, select New From.

Scenario 11

Scenario 22

Scenario 33

Product
Service
Request

PSR Order Split
Selection window

In the Service Request Search window, select a service request
and select Order Split.

Scenario 11

Scenario 22

Scenario 33

Product
Service
Request

Address tab In the TN Records Search window, open a telephone number. In
the E911 Extract window, click the Address tab.

Scenario 22

Customer
Accounts

List of Customer
Locations window

In the Customer Account Search window, from the Options menu,
select Customer Profile. In the Customer Summary window,
under Related Pages, click the Locations link.

Scenario 11

Scenario 22

Scenario 33

Customer
Accounts

List of Circuits/
Connections window

In the Customer Account Search window, from the Options menu,
select Customer Profile. In the Customer Summary window,
under Related Pages, click the Circuits/Connections link.

Scenario 11

Scenario 22

Scenario 33

Customer
Accounts

Customer Product
Transfer window

In the Customer Account Search window, from the Options menu,
select Customer Profile. In the Customer Summary window,
under Actions, click the Transfer link.

Scenario 11

Scenario 22

Scenario 33

Customer
Accounts

Customer Services
window

In the Customer Account Search window, open a customer
account. In the Customer Summary window, under Related
Pages, click the Services link.

Scenario 11

Scenario 22

Scenario 33

Equipment Location Search
window - Results tab

On the navigation bar, select Inventory Management, and then
click Equipment Inventory. Click the query button beside the
Location field. In the Location Search window, enter any search
criteria and click Search, and then click the Results tab.

Scenario 11

Scenario 33
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Table A-1    (Cont.) MSS UI Impacted After Resolution Process

Subsystem MSS UI Impacted Navigation Applicable
Scenario

Equipment Equipment Inventory
window

On the navigation bar, select Inventory Management, and then
click Equipment Inventory.

Scenario 11

Scenario 33

Equipment Hard-Wired Cross-
Connects window

In the Equipment Inventory window, right-click an equipment that
you want to cross-connect and select Cross-Connect. Right-click
another equipment and select Cross-Connect To.

Scenario 11

Scenario 33

Equipment Assembly Cross-
Connect Report

In the Equipment Inventory window, right-click an equipment and
select X-con Report.

Scenario 11

Scenario 33

Dedicated
Plant

Dedicated Plant
Search window

On the navigation bar, select Inventory Management, and then
click Dedicated Plant.

Scenario 11

Scenario 22

Scenario 33

Dedicated
Plant

Dedicated Plant
Maintenance window

In the Dedicated Plant Search window, open a dedicated plant. Scenario 11

Scenario 22

Scenario 33

Network
System

Managing a
Component window

In the Network System Design window, right-click a component
and select Properties.

Scenario 11

Scenario 33

Network
System

Network System
Design window

On the navigation bar, select Inventory Management, and then
click Network Systems. On the Network List panel, double-click a
template type or click the menu icon and select Search, and then
double-click a network system.

Scenario 11

Scenario 22

Scenario 33

Network
System

Network System
Print Preview

Open a network system. From the File menu, select Print. In the
Network Design Print window, click Preview.

In the Trouble Ticket Queue window or the Trouble Ticket Search
window, click the Service Item tab, and then click View Net
Design.

Scenario 11

Scenario 33

Network
System

Customer
Connections window

In the Network System Design window, right-click a component
and select Customer Connections.

Scenario 22

Network
System

Viewing Extensions
window

In the Network System Design window, right-click a component
and select Customer Connections. Double-click the Customer
Connections window.

Scenario 22

End User
Location

End User Location
Maintenance window

In the End User Location Search window, open an end user
location.

Scenario 11

Scenario 22

Scenario 33

End User
Location

Additional
Addresses tab

In the End User Location Maintenance window, click the
Additional Addresses tab.

Scenario 11

Scenario 22

Scenario 33

End User
Location

Terminal Location
window

In the Terminal Location Search window, open a terminal location.
In the Terminal Location window, click the rightmost icon at the
bottom of the window.

Scenario 11

Scenario 22

Scenario 33

Access Service
Request

Service Address
Location Information
List window

Open an ASR order. Under SALI, click Address Detail. Scenario 11

Scenario 22

Scenario 33
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Table A-1    (Cont.) MSS UI Impacted After Resolution Process

Subsystem MSS UI Impacted Navigation Applicable
Scenario

Access Service
Request

Service Address
Location Information
Maintenance window

Open an ASR order. Under SALI, click Address Detail. In the
Service Address Location Information List window, double-click a
link.

Scenario 11

Scenario 22

Scenario 33

Access Service
Request

CABS Billing
Navigator window

In the Service Request Search window, from the Options menu,
select CABS Billing.

Scenario 11

Scenario 22

Scenario 33

Local Service
Request

Location and Access
Maintenance window

Open an LSR order, under End User, click Location and Access
List.

Scenario 11

Scenario 22

Scenario 33

Local Service
Request

Location and Access
Detail window

Open an LSR order, under End User, click Location and Access
List. In the Location and Access Maintenance window, click a link
in the LOCNUM column.

Scenario 11

Scenario 22

Scenario 33

Local Service
Request

Service-specific
forms

Open an LSR order and navigate to the service-specific form, and
then click a link in the LOCNUM column.

Scenario 11

Scenario 33

Internal
Service
Request

Locations tab In the Service Request Search window, open an ISR order, and
then click the Locations tab.

Scenario 11

Scenario 22

Scenario 33

Internal
Service
Request

Internal Service
Request Location
Maintenance window

In the Service Request Search window, open an ISR order, and
then click the Locations tab. On the Locations tab, double-click a
location.

Scenario 11

Scenario 22

Scenario 33

Engineering
Work Order

Manage Equipment
view

In the Engineering Work Order Search window, open a work
order. In the Engineering Work Order Summary window, under
Related Pages, click the Manage Equipment link.

Scenario 11

Scenario 33

Trouble Ticket Service Item tab On the navigation bar, select Order Management, and then click
Trouble Ticker Queue. In the Trouble Ticket Queue window, click
the Service Item tab.

Scenario 11

Scenario 22

Scenario 33

1 Scenario 1: Multiple end user locations having the same address.
2 Scenario 2: Multiple active addresses of same address format at the same end user location.
3 Scenario 3: Multiple end user locations having the same address in MSAG and OBF structured formats.
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B
MSS Database Tables Impacted by the
Resolution Process

This appendix provides information on Oracle Communications MetaSolv Solution (MSS)
database tables, which are impacted during the Address Correction Utility resolution process.

Table B-1 lists the impacted MSS database tables and the scenarios in which information is
inserted, updated, or deleted in each database table after the resolution process is completed
by the Address Correction utility.

Table B-1    MSS Database Tables Impacted After Resolution Process

Database Table Name Scenario 11 Scenario 22 Scenario 33

ASAP.ACCESS_BILLING_CIRCUIT_LOC Update Update N/A

ASAP.CABLE Update N/A Update

ASAP.CABLE_COMPLEMENT Update N/A Update

ASAP.CIRCUIT Update N/A Update

ASAP.CIRCUIT_LAYOUT_REPORT N/A Update N/A

ASAP.CIRCUIT_XREF Update N/A Update

ASAP.CUST_ACCT_LOCATIONS Update/Delete Update Update/Delete

ASAP.DEDICATED_CROSSCONNECT Update N/A Update

ASAP.DESIGN_LAYOUT_REPORT Update Update Update

ASAP.DESIGN_LINE Update N/A Update

ASAP.DESIGN_ORD_SUMM N/A Update N/A

ASAP.DL_DLR_LINE_ISI Update N/A Update

ASAP.DLR_CIRCUIT_DESIGN_LINE Update N/A Update

ASAP.E911_EXTRACT Delete Update Update

ASAP.EMP_APPT Update N/A Update

ASAP.END_USER_LOCATION Update/Delete N/A Delete

ASAP.END_USER_LOCATION_USAGE Update/Delete N/A Update

ASAP.EQ_LOCN_STRUC_HIER Update/Delete N/A Update/Delete

ASAP.EQUIPMENT Update N/A Update

ASAP.EUL_LSO Update/Delete N/A Update/Delete

ASAP.MSAG_ADDR_LOC Delete Delete Delete

ASAP.NA_NET_LOC Delete N/A Delete

ASAP.NET_LOC_ADDR Update/Insert/Delete Update/Insert/Delete Update/Insert/Delete

ASAP.NET_LOC_ADDR_PR_ADDR Update/Insert/Delete Update/Insert/Delete Update/Insert/Delete

ASAP.NET_LOC_REL Delete N/A Delete

ASAP.NET_LOC_TERM_LOC Update/Delete N/A Update/Delete
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Table B-1    (Cont.) MSS Database Tables Impacted After Resolution Process

Database Table Name Scenario 11 Scenario 22 Scenario 33

ASAP.NETLOC_CA_VALUE Delete N/A Delete

ASAP.NETWORK_LOCATION Delete N/A Delete

ASAP.NETWORK_LOCATION_USER_DAT
A

Delete N/A Delete

ASAP.NETWORK_NODE Update N/A Update

ASAP.NETWORK_ROUTE Update N/A Update

ASAP.NS_COMPONENT Update N/A Update

ASAP.PARTY Insert Insert Insert

ASAP.PARTY_ADDRESS Insert Insert Insert

ASAP.PARTY_ROLE Insert Insert Insert

ASAP.PARTY_ROLE_ADDRESS Insert Insert Insert

ASAP.SI_LOC Update Update Update

ASAP.SR_LOC Update/Insert/Delete Update/Insert/Delete Update/Insert/Delete

ASAP.SRSI_SI_LOC Update N/A N/A

SRSI_SR_LOC N/A N/A Update

ASAP.TANDEM_TYPE Delete N/A Delete

ASAP.USO_CIRCUIT_LOC Update N/A Update

1 Scenario 1: Multiple end user locations having the same address.
2 Scenario 2: Multiple active addresses of same address format at the same end user location.
3 Scenario 3: Multiple end user locations having the same address in MSAG and OBF structured formats.
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